React Native
Animation

Overview
• Goals of animation
• Stationary objects must overcome inertia as they start moving.
• Objects in motion have momentum and rarely come to a stop immediately.
• Animations allow you to convey physically believable motion in your interface.

• React Native provides two complementary animation systems:
• Animated for granular and interactive control of specific values
• LayoutAnimation for animated global layout transactions.

Animated API
• The Animated API is designed to make it very easy to concisely express a wide variety
of interesting animation and interaction patterns
• Animated focuses on declarative relationships between inputs and outputs,
• with configurable transforms in between, and
• simple start/stop methods to control time-based animation execution.
• Animated exports four animatable component types:
• View,
• Text,
• Image
• ScrollView
• You can also create your own using Animated.createAnimatedComponent().

Example 1: overview

4 Parts of an animation

import React from 'react';
import { Animated, Text, View } from 'react-native';
class FadeInView extends React.Component {
state = {
fadeAnim: new Animated.Value(0), // Initial value for opacity: 0

1. Must have a special value known as an
Animated.Value. Ranges in value between 0 and 1

}
componentDidMount() {
Animated.timing(
this.state.fadeAnim,

// Animate over time
// The animated value to drive

{
toValue: 1,
duration: 10000,

// Animate to opacity: 1 (opaque)
// Make it take a while

}
).start();
}

// Starts the animation

2. Must have an animation object such as
timing.Animated.timing:
The start() function begins the animation

Example 1
render() {
let { fadeAnim } = this.state;
return (
<Animated.View

// Special animatable View

3. need an animated component

style={{
...this.props.style,
opacity: fadeAnim,

// Bind opacity to animated value

4. Must set a style property with an Animate.Value

}}
>
{this.props.children}
</Animated.View>
);
}
}

Note: This View is related to the animation in 2. via the Animate.Value.
Here we use fadeAnim, so the Animated.timing that uses
this.state.fadeAnim will animate this View.

Example 1
// You can then use your `FadeInView` in place of a `View` in your components:
export default class App extends React.Component {
render() {
return (
<View style={{flex: 1, alignItems: 'center', justifyContent: 'center'}}>
<FadeInView style={{width: 250, height: 50, backgroundColor: 'powderblue'}}>
<Text style={{fontSize: 28, textAlign: 'center', margin: 10}}>Fading in</Text>
</FadeInView>
</View>
)
}
}

Nothing related to animation here except that a component that
animates itself (FadeInView) is included.

Example 1: detailed description
import React from 'react';
import { Animated, Text, View } from 'react-native';
class FadeInView extends React.Component {
state = {
fadeAnim: new Animated.Value(0), // Initial value for opacity: 0
}
componentDidMount() {
Animated.timing(
this.state.fadeAnim,

// Animate over time
// The animated value to drive

{
toValue: 1,
duration: 10000,

// Animate to opacity: 1 (opaque)
// Make it take a while

}
).start();
}

// Starts the animation

Constructor:
create a new Animated.Value
created an opacity of 0 (invisible)
value used to create opacity in compiled native code
Animated.timing:
one of three properties of an object that can be
animated
call the start function
pass the Animated.Value object
pass the set of properties that govern the animation
toValue: end value of the opacity (1 is fully
visible)
duration: number of milliseconds to animate
.start() begins the Animated.timing animation

Example 1
render() {
let { fadeAnim } = this.state;
return (
<Animated.View

// Special animatable View

style={{
...this.props.style,
opacity: fadeAnim,
}}
>
{this.props.children}
</Animated.View>
);
}
}

// Bind opacity to animated value

Note that we need an animated component

Example 1
// You can then use your `FadeInView` in place of a `View` in your components:
export default class App extends React.Component {
render() {
return (
<View style={{flex: 1, alignItems: 'center', justifyContent: 'center'}}>
<FadeInView style={{width: 250, height: 50, backgroundColor: 'powderblue'}}>
<Text style={{fontSize: 28, textAlign: 'center', margin: 10}}>Fading in</Text>
</FadeInView>
</View>
)
}
}

Change this by duplicating the Text component and changing the text.
What happens?
What happens when you change the height: 50 in the FadeInView to
height: 100?

Working with animations
• Animations are started by calling start() on your animation.
• start() takes a completion callback that will be called when the animation is
done.
• If the animation finished running normally, the completion callback will be
invoked with {finished: true}.
• If the animation is done because stop() was called on it before it could finish
(e.g. because it was interrupted by a gesture or another animation), then it
will receive {finished: false}.

Animatable components
• Only animatable components can be animated.

• These special components do the magic of binding the animated values to the properties,
• and do targeted native updates to avoid the cost of the react render and reconciliation
process on every frame.
• They also handle cleanup on unmount so they are safe by default.

• createAnimatedComponent() can be used to make a component animatable.
• Animated exports the following animatable components using the above
wrapper:
•
•
•
•

Animated.Image
Animated.ScrollView
Animated.Text
Animated.View

Configuring animations (overview)
• Animations are heavily configurable. Can tweak
•
•
•
•

Custom and predefined easing functions,
delays, durations,
decay factors,
spring constants, and more can all be tweaked depending on the type of
animation.

https://facebook.github.io/react-native/docs/animated#configuring-animations

Configuring animations (overview)
• Animated provides three animation types,
• Each animation type provides a particular animation curve that
controls how your values animate from their initial value to the final
value:
• Animated.decay() starts with an initial velocity and gradually slows to a stop.
• Animated.spring() provides a simple spring physics model.
• Animated.timing() animates a value over time using easing functions.
• supports animating a value over time using one of various predefined easing functions,
• or you can use your own.

https://facebook.github.io/react-native/docs/animated#configuring-animations

timing
• Easing functions are typically used in animation to convey gradual
acceleration and deceleration of objects.
• By default, timing will use a inout curve that conveys gradual acceleration
to full speed and concludes by gradually decelerating to a stop.
• You can specify a different easing function by passing a easing parameter.
• Custom duration or even a delay before the animation starts is also
supported.
Doesn’t appear that you can combine Easing functions

https://facebook.github.io/react-native/docs/animated#configuring-animations

timing
• The Easing module provides several predefined animations through
the following methods:
• Easing.back(amount) provides a simple animation where the object goes
slightly back before moving forward
• Easing.bounce provides a bouncing animation
• Easine.ease provides a simple inertial animation
• Easing.elastic(amount) provides a simple spring interaction

https://facebook.github.io/react-native/docs/easing

timing
• The Easing module provides three standard easing functions:
• linear
• quad
• cubic

• The poly function can be used to implement quartic, quintic, and
other higher power functions.
• Use: Easing.linear
https://facebook.github.io/react-native/docs/easing

timing

https://facebook.github.io/react-native/docs/easing

• Additional mathematical functions are provided by the following
methods:
•
•
•
•

bezier provides a cubic bezier curve
circle provides a circular function
sin provides a sinusoidal function
exp provides an exponential function

• The following helpers are used to modify other easing functions.
• in runs an easing function forwards
• inout makes any easing function symmetrical
• out runs an easing function backwards

• Use: Easing.in or Easing.inout

Configuring animations (overview)
• Example:
• create a 2-second long animation of an object that slightly backs up before
moving to its final position
Animated.timing(this.state.xPosition, {
toValue: 100,
easing: Easing.back(),
duration: 2000,
}).start();

Example 2
import React from 'react';
import { Animated, Text, View, Easing, Image, Dimensions } from 'react-native';
class MoveView extends React.Component {
State contains variables to control the animation
state = {
animatedValue: new Animated.Value(0), // Initial value for opacity: 0
startX: 100,
startY: 100,
endX: Dimensions.get('window').width-100,
The Dimensions component allows access to the window size
endY: Dimensions.get('window').height-100,
}

Example 2

Animated.timing takes two values:
the value to animate (this.state.animatedValue)
configuration properties in curly brackets.

componentDidMount() {
Animated.timing(
// Animate over time
this.state.animatedValue,
// The animated value to drive
{
toValue: 1,
// Animate to position: 1
easing: Easing.back(2), Easing property. Control how the animation starts/ends
duration: 9000,
// Make it take a while
}
).start();
// Starts the animation
}

Example 2

Note that transform is a style property

}

output value.

It’s an array with each element a different
render() {
transform.
return (
<View>
Here we have two elements, one to
<Animated.Image
// Special animatable View
transform X and one to transform Y
style={{
width: 227,
translateX and translate take a single value
height: 200,
which indicates where to move to
transform: [ {translateX: this.state.animatedValue.interpolate({
inputRange: [0, 1],
We want to move between values that are
outputRange: [this.state.startX, this.state.endX]
greater than 1. Our animated value is
})},
between 0 and 1. So we must interpolate.
{ translateY: this.state.animatedValue.interpolate({
inputRange: [0, 1],
The interpolate function takes one
outputRange: [this.state.startY, this.state.endY]
parameter with two properties: an array of
})},] }}
possible input values and an array of
source={{uri:"https://s3.amazonaws.com/mediap.slid.es/uploads/alexanderfarennikov/images/1198519/reactjs.png"}}>
possible output values.
</Animated.Image>
It locates animatedValue in the range of
</View>);
input values and returns the corresponding
}

Example 3: using a button

When clicked, the image backs up and
then moves down and to the right.

Example 3: using a button

anim3.js on the class web site

import React from 'react';
import { Button, Animated, Text, View, Easing, Image, Dimensions } from 'react-native';
class MoveView extends React.Component {
constructor(props){
super(props);
this.state = {
animatedValue: new Animated.Value(0), // Initial value for opacity: 0
startX: 100,
State contains variables to control the animation
startY: 100,
endX: Dimensions.get('window').width-100,
endY: Dimensions.get('window').height-100,
}
}

Example 3: using a button
The animation is the same except that it occurs in a function
doAnimate = () => {
this.state.animatedValue.setValue(0); Reset the Animated.Value so that the animation
runs from the start
Animated.timing(
// Animate over time
this.state.animatedValue,
// The animated value to drive
{
toValue: 1,
// Animate to position: 1
The animation box
easing: Easing.back(2),
duration: 9000,
// Make it take a while
}
).start();
// Starts the animation
}

Example 3: using a button
render() {
return (
<View style={{flex:1}}>
<View style={{flex:3}}>
<Animated.Image
style={{
width: 227,
height: 200,

We use flex to position components
There is an outer view and two components.
Each components is inside a view.

// Special animatable View
The beginning of the image that will be animated (cont on next slide)

Example 3: using a button
Style property: transform
transform: [ {
translateX: this.state.animatedValue.interpolate({
Will transform 2 properties:
translateX
inputRange: [0, 1],
translateY
outputRange: [this.state.startX, this.state.endX]
})},
{
translateY: this.state.animatedValue.interpolate({
inputRange: [0, 1],
outputRange: [this.state.startY, this.state.endY]
})},] }}
source={{uri:"https://s3.amazonaws.com/mediap.slid.es/uploads/alexanderfarennikov/images/1198519/reactjs.png"}}>
</Animated.Image>
End of the Animated.Image component
</View>
End of the View which is around the Animated.Image component

Example 3: using a button

}

<View style={{flex:1}}>
<Button
onPress = {this.doAnimate}
Add a button to call the doAnimate function
color="#841584"
title="Click to animate"
accessibilityLabel="Animation button"/>
</View>
End of the View which is around the Button component
</View>);
End of the View which is around both components
}

export default class App extends React.Component {
render() {

}

}

return (
<View style={{flex: 1, }}>
<MoveView />
</View>
)

Get this running.
Then add a second animation with a second button.

interpolation
• Each property can be run through an interpolation first.
• An interpolation maps input ranges to output ranges,
• typically using a linear interpolation but also supports easing functions.
• By default, it will extrapolate the curve beyond the ranges given, but you can
also have it clamp the output value.

interpolation
• A simple mapping to convert a 0-1 range to a 0-100 range would be:
value.interpolate({
inputRange: [0, 1],
outputRange: [0, 100],
});

Interpolation: You can interpolate to non-numeric values also.
spinValue = new Animated.Value(0)
// First set up animation
Animated.timing(
this.spinValue,
{
toValue: 1,
duration: 3000,
easing: Easing.linear
}
).start()

Get this to run in a new project with an image

// Second interpolate beginning and end values (in this case 0 and 1)
const spin = this.spinValue.interpolate({
<Animated.Image
inputRange: [0, 1],
style={{transform: [{rotate: spin}] }}
outputRange: ['0deg', '360deg']
source={{uri: 'somesource.png'}} />
})

interpolation
• interpolate() supports multiple range segments as well.
• example, to get a negation relationship at -300 that goes to 0 at -100, then
back up to 1 at 0, and then back down to zero at 100 followed by a dead-zone
that remains at 0 for everything beyond that:
Input | Output
value.interpolate({
inputRange: [-300, -100, 0, 100, 101],
outputRange: [300, 0, 1, 0, 0],
});

------|-------400| 450
-300| 300
-200| 150
-100| 0
-50| 0.5
0| 1
50| 0.5
100| 0
101| 0
200| 0

Interpolation
• interpolate() also supports arbitrary easing functions, many of which
are already implemented in the Easing module.
• interpolate() also has configurable behavior for extrapolating
the outputRange.
• You can set the extrapolation by setting
the extrapolate, extrapolateLeft,
or extrapolateRight options.
• The default value is extend but you can use clamp to prevent the
output value from exceeding outputRange.

interpolation
• Can dynamically track other Animated.values
• See https://facebook.github.io/react-native/docs/animations

